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1 User Guide Revisions

Revision Release Date Notes

1 June 2010 Initial release

1.1 December 2011 Updated to include family tree tab on animal record and associated 
changes with this, time stamp corrections in program settings, and out 
of parlour time in stall information.

1.2 January 2012 Updated to include extra Milk Yield Source option for NMR DataStream 
disks.

1.3 July 2012 Updated to include blocking external programs from updating milk yield
information.

1.4 September 2013 Updated to include Exporting of data from the Report Preview window.

1.5 July 2014 Updated to include uploading and downloading of settings from the 
ATL Micro Marque 3s control.
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2 Getting Started with ATL Cowculator 2010
Welcome to ATL Cowculator 2010. This part of the user guide will help you to install, configure and then
connect the ATL Cowculator 2010 program to your ATL parlour or out of parlour control.

2.1 Program Requirements

ATL Cowculator requires a Microsoft Windows based PC with the following minimum specification:

• Supported Operating Systems: Windows 7; Windows Vista; Windows XP

• Processor: 500 MHz processor or equivalent (Minimum); 1GHz processor or equivalent 
(Recommended)

• RAM: 512 MB (Minimum); 1 GB (Recommended)

• Hard Disk: Up to 520 MB of available space may be required

• CD or DVD Drive: CD-ROM or DVD drive required for installation

• Display: 800 x 600, 256 colours (Minimum); 1024 x 768 high colour, 32-bit (Recommended)

• In Parlour Communications: 

◦ ATL Micro Marque 3s: 1x USB or RS-232 communications port

◦ ATL Micro Marque 4: 1x Ethernet connection

• Out of Parlour Communications: 

◦ Mk3 Out Of Parlour: 1x USB or RS-232 communications port

◦ ATL Micro Marque 4: 1x Ethernet connection

2.2 Installation

To start the installation process, please insert the ATL Cowculator 2010 CD into your CD-ROM drive.
Once the CD has been loaded, the CD will auto-run and load the installation program. If the CD fails to
auto-run, the installation program can be manually started by browsing the CD's contents and double
clicking on the “setup.exe” program.

During the initial  start-up of the installation program, the program will  check the operating system
version and make sure it has any required updates. If any required updates are missing they will be
installed automatically, providing the computer is connected to the internet.

Continued overleaf...
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The ATL Cowculator 2010 setup wizard will be displayed when all required updates have been installed.
The wizard is shown below:

If at any time the user wishes to cancel the installation, they can do so by clicking the 'Cancel' button on
the wizard.

The  select  installation  folder  screen allows  the  user  to  manually  select  where  the  program will  be
installed to, it is not recommended to change this setting unless it is absolutely necessary. The user can
also select if other users on the computer are allowed to use the program.
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The next screen is the final screen before installation, this allows the user to cancel the installation if
necessary. The screen is shown below:

During the installation, the wizard will report its progress using a progress bar. This screen is shown
below:
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Once installation has been completed the final screen will be shown.

Clicking 'Close' will close the wizard. 

The Program can now be run by clicking on the “ATL Cowculator 2010” icon on the desktop. The icon is
shown below;
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3 About ATL Cowculator 2010
ATL Cowculator 2010 provides complete control of your herd. Access all the information stored in the
parlour control and use it to improve milking performance. Also recall all information from the out-of-
parlour system, view attentions and highlight problem cows.

3.1 Milking

ATL Cowculator 2010 stores milk yields from multiple lactations, allowing animal performance to be
monitored on a milking by milking basis over the animal's lifetime. Predicted daily yields calculated from
each animals milk production rate, highlights any milk yield deviations and possible health issues as
soon as they happen. 

Herd performance can also be monitored with graphical data available on yearly, monthly and daily
milking and feed totals. 
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3.2 Feeding

Three simple ration calculations provide options for controlling how the animals are fed. These can be
applied on an individual or group basis, and can be split between parlour and out of parlour feeders.
The three types of ration calculation are:

• Feed Table - Simple feeding

• Feed to Yield - Target  animals based upon their individual yields

• Ration Curve - Target animals based on their days in milk

When connected to out of parlour feeders, the number of visits, the amount of uneaten feed and the
daily feed history can be viewed.
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The feeding process can also be broken down into four sections - steaming up, lead feeding, ration
feeding and drying off. 

3.3 Sorting

More advanced animal sorting is also available within Cowculator 2010. Animals can be sorted always,
once only or by date, giving the user more features than on the stand-alone sorting system.

3.4 Cow Calendar

Use the calendar  to easily  check each animal's  position in  the  lactation  cycle  and highlight  which
animals are not performing.
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3.5 Health Records and Medicine Use

Individual animal health records provide simple and effective logging of problems. Simple search and
sort function allows animals with problems to be found and sorted for attention. Attentions can be
logged against cows, such as high cell count, mastitis, low yields and foot attention. 

Medicine use on animals can be recorded using the medicine editor, allowing a full history of medicine
use to be recorded for individual animals.

3.6 Scheduled Tasks

ATL Cowculator  2010 also has  scheduled tasks  which allows the user  to set  automatic  downloads,
uploads and ration calculation at scheduled times each day.  This reduces the need for the user to
remember to carry out the download and allows complete lactation milk yield and feeding information
to be stored for management purposes.

3.7 Reports

Design custom reports using the in-built, easy to use report designer.
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4 Starting ATL Cowculator 2010 for the First Time

4.1 First Run Wizard

When the program is run for the first time, the program will  show the First  Run Wizard which will
perform the final steps to installing and getting the program started. The Wizard is shown below;

The wizard will show the End User License Agreement (EULA) for ATL Cowculator 2010. This will need to
be agreed with to use the program.
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The next screen shown after the EULA screen is the Product Key entry screen. This is where the Product
Key for your copy of ATL Cowculator 2010 needs to be entered.

The product key must be entered exactly as it is printed on the sticker inside the front cover of the CD-
ROM case. When the a valid key is entered the red cross will change to a green tick and the 'Next'
button will become click-able. 

The goal of Product Activation is to reduce a form of piracy known as "casual copying" or "softlifting."
Casual copying is a form of piracy characterized by the sharing of software between people in a way
that  infringes  on  the  software's  end  user  license  agreement  (EULA).  For  instance,  Windows  XP  is

primarily licensed for use on a single PC and without purchasing additional licenses cannot be installed
on other machines. If someone were to obtain a copy of Windows XP and load it on his or her PC, then
share it with a second person who loaded it on his or her PC, they would be guilty of casual copying.

16



                  Innovation In and Out of Parlour ATL Cowculator 2010 - User Guide

Most licenses allow software to be re-installed and activated on the same PC an unlimited number of
times. To ensure that you are using your license properly, please see your end user license agreement or
product use rights for details on a specific product.

Casual copying accounts for a large portion of the economic losses due to piracy. Over time, reduced
piracy means that the software industry can invest more in product development, quality and support.
This ensures better products and more innovation for customers. Ultimately, customers will benefit from
the economic impact of reduced piracy through increased job opportunities and higher wages.

Customers may activate the product via one of two methods:

1. Internet. ATL servers process the activation and silently activate the product.
2. Telephone. Customer service representatives process activations and exceptions.

Once the product key is entered the wizard is finished. Click Finish to load the program.

4.2 Connecting ATL Cowculator to an ATL Control

ATL Cowculator  2010 features  a new system where-by the communications  ports  are automatically
detected and tested to see if they are connected to an ATL control. This configuration allows the user to
simply click upload or download and have the program configure itself. 

The only  requirements are that the program is correctly set up so that the correct controls will  be
searched for. This can be done by selecting the types of controls from the Settings dialog. See Chapter
7 for more information.
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4.3 The ATL Cowculator Main Window and Welcome Screen

The  welcome screen is  a  special  screen  designed  for  the  user  to  quickly  access  core  parts  of  the
program. The screen is shown when ATL Cowculator first loads, and can be accessed at all times by

clicking the “Show Welcome Screen” button   on the toolbar.

Main Menu Bar

Tool Bar

Navigation Menu

Welcome Screen

Status Bar

The welcome screen contains 4 link lists, each dealing with a specified area. These quick links provide
fast access to lists of cows. For example, the “Cows with low yields” link allows users to access cows
which have not produced enough milk in accordance with their predicted daily yield.

If the welcome screen is closed, it is replaced by a list view showing the cow number, status and other
information.  This list view is by default ordered by cow number.

The screen is made up of five main areas; the main menu bar, the tool bar, the navigation menu, the
welcome screen or list view, and the status bar.

These are covered in the following chapters.
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5 The Main Menu Bar
The main menu bar provides access to the main functions of ATL Cowculator 2010. These functions are
grouped under the following headings; File, Edit, Settings, Tools and Help.

5.1 The File Menu

The File menu provides short cuts for herd based functions;

• Send to ATL Micro Marque 3s: Send all data to the ATL Micro Marque 3s control. See Chapter 8
for more information. 

• Get from ATL Micro Marque 3s: Get all data from the ATL Micro Marque 3s control. See Chapter
8 for more information. 

• Send to ATL Out of Parlour: Sends all data to the ATL Out of Parlour control. See Chapter 8 for
more information. Please note that this item is only visible if the program has the Out of Parlour
control enabled in the settings.

• Get from ATL Out of Parlour: Get all data from the ATL Out of Parlour control. See Chapter 8 for
more information. Please note that this item is only visible if the program has the Out of Parlour
control enabled in the settings.

• Print Reports: This menu contains a sub-menu that allows the user to select the printout type
they require. See Section 25 for descriptions of all the reports available for printing.

• Import Data: This menu item allows the user to import data from various file formats into ATL
Cowculator. See Section 8 for more information.

• Backup Cow Data: This will save a back-up copy of the cow database in the location of your
choice. See Section 24 for more information.

• Restore Cow Data: This will restore a back-up copy of the cow data file into the cow database.
See Section 24 for more information.

• Exit: This will exit the program, saving the data automatically.
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5.2 The Edit Menu

These commands perform the following functions;

• Undo: Undoes the previous action on a cow.

• Redo: Redoes the previously undone action on a cow.

• Create a New Cow: Shows the New Cow(s) dialog, See Chapter 8 for more information.

• Edit Cow Information: Shows the Cow Record screen and allows the display of more detailed
information on an individual cow. See Chapter 19 for more information.

• Delete a Cow: Opens the Delete Cows dialog. See Chapter 11 for more information.

• Calculate Rations: Performs the Ration Calculation routine. See Chapter 19 for more information.

• Cow Operations: Opens the Cow Operations dialog, See Chapter 9 for more information.

• Brand Options: Opens the Brand Options dialog. Allows users to easily change animals freeze
brands and ear tags. See Chapter 10 for more information.

• Herd Statistics: Opens the Herd Statistics dialog. See Chapter 22 for more information.

• Search for Cow(s): Opens the Search for Cows dialog, allowing recursive searches through the
cow data. See Chapter 23 for more information.

• Clear Search Filters: Clears all searches and shows all cows in the Cow List View.
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5.3 The Settings Menu

The Settings menu provides access to settings in ATL Cowculator.

• ATL Cowculator: Shows the Program Settings dialog for ATL Cowculator, See Chapter 7 for more
information.

• Medicines:  Shows the Medicine Editor,  allowing the user  to input  medicines for  use by the
program. See Chapter 17 for more information.

• Groups: Shows the Groups configuration screen, This gives options for ration calculations and
group drafting. See Chapter 20 for more information.

• Ration  Calculations:  This  opens  the  ration  calculations  editor.  See  Chapter  21  for  more
information.

• Report Designer: This opens the report designer. The report designer allows users to design
their own reports for printing. See Chapter 25 for more information.

5.4 The Tools Menu

The Tools menu consists of useful functions for use in the ATL Micro Marque 4.

• Manual Drafting Control: This tool allows the user to control the drafting gates manually. Please
Note: This tool is only available for the ATL Micro Marque 4.

• Drafting  Gate  Watcher:  This  tool  watches  all  tags  passing  through  a  drafting  gate.  It  then
displays the tag code and animal number if it is linked. Please Note: This tool is only available for
the ATL Micro Marque 4.

• Drafting Gate Tag Linker:  This tool watches for unlinked tags being detected by any of the
drafting gates connected to the Micro Marque 4 system. The user can then choose to link the
tag to a cow number or to skip it.  Please Note: This tool is only available for the ATL Micro
Marque 4.
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• Feed Usage Monitor: This tool allows you to monitor the feed being used by the system. Please
Note: This tool is only available for the ATL Micro Marque 4.

• Create Dummy Herd Data: This menu item will create dummy cows with dummy information.

More information on these tools is available in Chapter 28.

5.5 The Help Menu

The Help menu allows access to this user guide and the 'About' dialog. As well as the following:

The  “Request  Assistance”  menu  item  allows  the  user  to  directly  ask  ATL  for  help  by  sending  an
automatic email with the users contact information and a copy of the database.

The "ATL on the Internet" menu item takes the user to the ATL website.

The “Check for updates” menu item checks on the Internet for a newer version of the program, if one is
available it will download the new update and allow the user to install it.

Please Note: The “Request Assistance”,  “ATL on the Internet” and “Check for Updates” menu items all
require an internet connection.
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5.5.1 Requesting Assistance

The user can request help from ATL by clicking the “Request Assistance” menu item on the help menu.
This will open the Request Assistance dialog, which is shown below. The user must enter their name and
a contact method, either through email or phone, and a description of the problem. When the user
clicks send, it will make an Assistance Request to ATL containing the cow data. ATL will then contact the
user.
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6 The Tool Bar
The tool bar contains a row of icons for the more frequently used commands. 

• The Show Welcome Screen button  shows the welcome screen.

• The Create New Cow(s) button   shows the New Cows(s) dialog. See Chapter 8 for more
information.

• The Edit Cow Information button  shows the currently highlighted cow in the Cow Record
screen. See Chapter 19 for more information.

• The Delete Cow button  deletes the currently highlighted cow or cows. See Chapter 11 for
more information.

• The Print button  shows the Open Report dialog, See Chapter 25 for more information.

• The Administer Medicine Dose button  allows the user to administer a medicine dose to a
single  cow  or  multiple  cows  that  are  selected  in  the  list  view.  See  Chapter  17  for  more
information.

• The Calculate Rations button  shows the Calculate Rations dialog. See Chapter 21 for more
information.

• The Undo button  undoes the last action.

• The Redo button  redoes the last undone action.

• The Quick Find Cow entry box  allows the user to simply enter a cow
number into the box and ATL Cowculator will find the cow in the list and select the row. See
Chapter 23 for more information.

• The Search button  shows the Search dialog. See Chapter 23 for more information.

• The  Clear  Search  button   clears  the  current  search  filters.  See  Chapter  23  for  more
information.

• The Mark Cows for Drafting button  shows the Mark Cows for Drafting dialog. See SChapter
19 for more information.

• The Cow Operations button   shows the Cow Operations dialog. See Chapter 9 for more
information.

• The 'Send to' and 'Get from' buttons;  and  respectively. These two buttons instruct the
ATL Cowculator  program to send /  get cow data to and from any connected controls.  See
Chapter 8 for more information.

• The Help button  shows this file.
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7 The Navigation Menu

Operations Area 

Links Buttons

The navigation menu is designed to allow the user quick access to commonly performed tasks.

The menu is made up of two main areas. The first is the bottom link buttons, which allow the user to
switch between 5 different areas of the program - Cow Information,  Milking,  Feeding, Drafting and
Health. 

The second is the operations area which provides the user with quick links to operations on the data
displayed. The operations area changes its contents according to the data which is being displayed. So
in the example above, the operations area allows the user to drill down into the cow information and
see specific information about calving animals or young stock, or change the status or group of an
animal.
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8 Cowculator Settings
The  ATL Cowculator  Settings  dialog allows  users  to change  various  program settings.  Settings  are
available for the out of parlour feeding system, calendar, feeding, importing, customising columns and
scheduled tasks.

The ATL Cowculator Settings dialog can be found by clicking on Settings on the Main Menu bar, and
then ATL Cowulator. Each setting is detailed below:

8.1 The Program Settings Tab

The program settings tab allows the user to change settings for ATL Cowculator 2010.

8.1.1 Animal Type

ATL Cowculator 2010 can be used on with ATL equipment on systems for cows, sheep or goats. The 
program will changes the wording depending on which animal type is selected. Please select the correct
animal type using this drop down menu. 

8.1.2 In Parlour Control and Out of Parlour Control

These settings allow the user to change the type of control that is connected to the ATL Cowculator 
2010 program. ATL Cowculator 2010 supports both the in parlour and out of parlour systems, the user 
can select which systems are connected to the control using this screen.

• In Parlour Control - Either MicroMarque3S or MicroMarque4

• Out of Parlour Control - ATL Out of Parlour

8.1.3 Daily Milk Pickup

ATL Cowculator 2010 allows the user to change the time that their milk processor collects their milk and
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therefore change all the milk totals throughout the program. This allows the user to compare the total
milk yields with the milk tanker printout and show the accuracy of the milk meter system and forward
plan using the historical data stored within the program.

The following diagrams explain which milk  yields are used within the totals  depending on whether
morning, afternoon or evening milk pick up is selected.

• Blue Box - Milkings included within the blue box are used to calculate yesterday's milk yield
total.

• Red Box - Milkings included within the red box are used to calculate today's milk yield total.

Morning Daily Milk Yield Pickup

Should  be  selected  on farms  where  the  milk  processor  collects  milk  after  the  morning  milking.  If
morning daily milk pick up is selected, the following milking are used to calculate milk yield totals:

Milkings
per Day

Day Before Yesterday Yesterday Today

1 1 1 1

2 1 2 1 2 1 2

3 1 2 3 1 2 3 1 2 3

Afternoon Daily Milk Yield Pickup

Should  be  selected  on  farms  where  the  milk  processor  collects  milk  after  the  midday  milking.  If
afternoon daily milk pick up is selected, the following milking are used to calculate milk yield totals:

Milkings
per Day

Day Before Yesterday Yesterday Today

1 1 1 1

2 1 2 1 2 1 2

3 1 2 3 1 2 3 1 2 3

Evening Daily Milk Yield Pick Up

Should be selected on farms where the milk processor collects milk after the evening milking. If evening
daily milk pick up is selected, the following milking are used to calculate milk yield totals:

Milkings
per Day

Day Before Yesterday Yesterday Today

1 1 1 1

2 1 2 1 2 1 2

3 1 2 3 1 2 3 1 2 3
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8.1.4 Auto-complete Tag Numbers

The screen also allows the user to specify auto-complete on tag numbers allowing the user to only type 
in the significant lower digits of a tag code. The program will complete the code for the correct type of 
tag. 

• Disabled - Do not auto-complete tag numbers

• UK Reusable - Auto-complete UK resuable tag numbers

• UK Non-Reusable - Auto-complete UK non-reusable tag numbers

Please note that alpha numeric animal numbers are only available on the MicroMarque4.

8.1.5 Enable Feeding Information

This allows the user to hide the feeding information tab on the navigation menu if the system is on a 
non-feeding parlour and does not have an out of parlour feeding system connected.

8.1.6 Correct Time Stamps When Downloading from MicroMarque3S

This setting allows users with older version of software in their parlour controls, to introduce the correct 
times of milkings for the animals. This allows the program to make a prediction for the production rates 
of the animals.

8.2 The Out of Parlour Settings Tab

The Out of Parlour Settings tab allows the user to choose certain settings if ATL Cowculator 2010 is 
connected to an out of parlour system.

The following settings are user selectable:

• System Type - Select either A Feeder Only (one feeder per station) or A and B Feeders (two
feeders per station).
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• Number of Days to Calculate Averages Over - This is the number of days to calculate average
visits and average uneaten feed over (shown on Feeding tab of Cow Record).

• Uneaten Feed Warning Level - The amount of feed left uneaten before a warning is generated
within ATL Cowculator 2010.

• High Visit  Warning  Level  -  The number  of  visits  before  a  warning  is  generated within  ATL
Cowculator 2010.

• Carry Uneaten Feed Over to In Parlour – This box adds any uneaten feed in the 24 hour cycle on
the out of parlour feeding system to the following days parlour feed ration.

8.3 The Calendar Settings Tab

The Calendar Information tab allows the user to change the calendar settings of the program. These
settings are used when calculating the predicted status for cows.

The following settings can be changed:

• Days before Pregnancy Diagnosis - This is the number of days after an animal has been serviced
that a pregnancy diagnosis attention will be raised.

• Days before Steaming Up - This is the number of days to wait after an animal has been dried off
before steaming up can begin.

• Days between Heat Cycles - This is the number of days between consecutive heat cycles. The
next heat cycle date will be displayed in the animals Next Heat Cycle field.

• Days until Calving - This is the number of days between an animals calving date and the service
date after the animal has been marked as pregnant in the status selection box. The predicted
next calving date value is calculated from the service date plus the number of days entered.

• Days until First Heat - This is the number of days until a young animal will come into heat. The
date is calculated using the birth date of the animal. 

• Days until Heat after Calving - This is the number of days after an animal has calved that she will
come into heat.

• Days until Next Service - This is the number of days until the next recommended service.
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• Drying off Period Start - This is the number of days before the predicted calving date that the
animal will be flagged as requiring drying off.

• Dry Period Start - This is the number of days before the predicted calving date that the animal
will be flagged as requiring to be dry.

8.4 The Feed Cycle Settings Tab

The Feed Cycle  Settings tab allows  the user  to change settings  specifically  related to feeding.  The
settings include steaming up, lead feeding, rationing and drying off. This is based on feeding cows.

8.4.1 Steaming Up

Steaming up is the feeding of rations to late pregnant cows in an attempt to promote maximum milk
production from the very beginning of the lactation. Steaming up usually commences about 4 weeks
before the due date. 

Steaming up is disabled by default. When the tick box is checked and the steaming up functions are
enabled, the user can enter a curve to steam-up to. The curve can have as many points on as the user
requires. The time between each point is called a leg. Each leg has an associated ration.

The steaming up calculation will only be used when the cow's status is set to steaming up. The process
will continue until the end of the curve, or until the cow's status is changed to calved.
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8.4.2 Lead Feeding 

Lead feeding is the feeding of rations to newly calved cows, building their rations up to the normal
rationing level.  Lead feeding is usually carried out for about 4 weeks after calving.

Lead feeding is disabled by default. When the tick box is checked and the lead feeding functions are
enabled, the user can enter a curve to lead feed to. The curve have as many points on as the user
requires. The line between each point is called a leg. Each leg has an associated ration.

The curve will start when the cow status is set to “Calved” and continue for the length of the curve, after
which the rationing settings for that cows group will be used for calculating rations.

8.4.3 Rationing

Rationing is the standard feeding regime for the cows. There are various options for ration feeding that
can be carried out from ATL Cowculator 2010. This is the part of the feeding regime where the ration
calculations can be fed to the cows. Please note that ration calculations do not have to be used within
this section of the feeding regime. Custom feeding regimes which are manually entered by the user on
an individual cow basis are also available, along with flat rate feeding

The following settings can be changed by the user:

• Milkings per Day - The number of milkings per day. If set to two milkings per day, the milk yield
graph will show morning and evening milkings. Where as, if set to three milkings per day, the
milk yield graph will show morning, midday and evening milkings.
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• Milk Yield Source - The milk yield source value is the milk yield used within the feed table and
feed to yield ration calculations. The milk yield source values are dependent upon the Daily Milk
Pickup Time chosen in the Cowculator Settings. See Chapter 7 for more information. It can be
one of the following:

• Yesterdays Daily Milk Yield - The daily milk yield recorded yesterday.

• Average Daily Yield - The average daily milk yield over a user-selectable number of days.

• Predicted Daily Yield - The calculated predicted daily yield using the production rate.
This is the average production rate over the last 14 days.

• Newest Recording – The newest recording. This setting is only recommended for users
using the NMR DataStream import facility.

• Number of Days to Average - This is the number of days to average the daily milk yield over, to
provide the Average Daily Yield. Only available if Average Daily Yield selected from "Milk Yield
Source" drop-down.

• Exclude days with missing milkings from average - This removes rogue values from the average
calculations, thereby preventing large reductions in the average daily yield and affecting feeding
regime.

• Feed per  Unit  –  The amount  of  feed which  represents  one unit  in  the parlour  control.  For
example, the parlour control could be calibrated to one feed unit equalling 0.5 kilograms of
feed.  Therefore,  this  should  be  set  to  0.5  kilograms,  otherwise  the  rations  will  not  be  fed
correctly.

8.4.4 Drying Off

The drying off setting allows the user to set the feeding regime for cows during both the drying off and
dry periods. The drying off period involves the reduction in feeding down to a low-level or zero during
the dry period. The drying off feeding regime will occur when a cow's status is changed to drying off
and will continue until the drying off period ends and the cow's status is changed to dry.

There are several options for feeding cows during the drying off period. These are:

• Disable Drying Off, Use feed for dry cows value - This setting will disable drying off and any
cows will be allocated the 'feed for dry cows' feed value.
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• Disable Drying Off, Use current feed - This setting will disable drying off and any cows will not
have their allocation changed from the rationing period.

• Reduce feed over whole drying off period - This setting uses two settings from the Calendar
Settings to calculate the length of the drying off period and then reduces feed by a set amount
each day until it reaches the feed for dry cows feed value. 

For example , if a cow is being fed a ration of 4.2 kilograms at the end of the rationing period, the
default setting for the Drying Off Period Start is 70 days, the Dry Period Start is 56 days, and the feed for
dry cows is set to 0.00 kilograms. This means that the drying off period is 14 days. Therefore, the ration
will be reduced by 0.3 kilograms per day until the dry period starts.

• Reduce feed by a set amount per day - This setting allows the user to reduce the feed amount
by a set amount per day over the drying off period.

• Feed for dry cows value - the amount of feed in kilograms that dry cows will be fed each day.
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8.5 The Import Options Tab

The  Import  Options  tab  allows  the  user  to  edit  the  way  external  software  programs  access  ATL
Cowculator 2010. 

The following settings are available:

• Program  -  Choose  the  program  the  settings  are  to  affect.  Options  are  import  dialog,
MicroMarque3S upload / download or external application.

• Allow this application to change electronic ID tag codes - ticked by default - un-tick the check
box if the program is not to change the electronic tag codes.

• Allow this application to change Milk Recording Values – un-tick to stop the application from
changing the milk recording information.

• Flags - Instructs the program on how to treat the attention flags - options are normal, first left,
first right, second left, second right or ignore.

8.6 Column Settings Tab

The Column Settings tab allows the user to change each view in ATL Cowculator 2010 to contain the
data fields they require. The drop-down menu lets the user choose the view to be changed.

Choose View

Columns                                                                                                                                  Columns

Available                                                                                                                                  Displayed
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8.7 The Scheduled Tasks Tab

The scheduled tasks tab allows the user to create scheduled tasks which automatically download the
cow data from the MicroMarque3S and/or Out of Parlour control, calculate rations and then upload the
data back to relevant controls. Therefore, this is designed to remove the need for the user to remember
to carry out these tasks. For the scheduled tasks to work, it is recommended that the computer is left on
all the time. 

Even  if  ration  calculations  are  not  being  used,  and  the  system is  connected  to  milk  meters,  it  is
recommended that the cow data is automatically downloaded from the MicroMarque3S to store the
milk yields for each animals entire lactation.

To create a new scheduled task the user can click the Add Task button. This will open the scheduled task
dialog and the scheduled task can be created. 
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This is the same dialog as the Edit Task button will show. The following settings are user selectable:

• Schedule Type - Daily or weekly

• Enabled - If  the check box is ticked the scheduled task is enabled and if  it  is un-ticked the
scheduled task is disabled and will not run.

• Trigger Time - The time the scheduled task should run. Milking times should be avoided for all
downloading and uploading of cow data to Micromarque3S.

• Day of Week - Only available if scheduled task selected to be run weekly.

• Tasks - There are eight scheduled task to choose from. They are as follows:

1. Upload to MicroMarque 3s Control - This task will only upload the cow data to the
MicroMarque3s Control.

2. Download from MicroMarque3s Control - This task will only download the cow data 
to the MicroMarque3s Control.

3. Upload to Mk3 Out of Parlour Control - This task will only upload the cow data to
the ATL Mk3 Out of Parlour Control.

4. Download from Mk3 Out of Parlour Control - This task will only download the cow
data to the ATL Mk3 Out of Parlour Control.

5. Calculate Rations - This task will only calculate the rations for the entire herd.

6. Calculate Rations for MicroMarque3s Control - The task will download the cow data
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from  the  MicroMarque3s  control,  calculate  the  rations  from  the  new  milk  yield
information and then upload the new cow data back to the MicroMarque3s control.

7. Calculate Rations for the Mk3 Out of Parlour - The task will download the cow data
from the ATL Mk3 Out of Parlour control, calculate the rations and then upload the
new cow data back to the ATL Mk3 Out of Parlour control.

8. Calculate  Rations  for  MicroMarque3s  and  Mk3  Out  of  Parlour  -  The  task  will
download the cow data from the MicroMarque3s control and also download the
ration usages from the ATL Mk3 Out of Parlour control, calculate the rations from
the new milk yield information and then upload the new cow data back to both the
MicroMarque3s control and the Mk3 Out of Parlour control.

9. Backup Cow Data – This task will automatically perform a backup of the data.

10. Print Reports – This task will automatically print a user selected report.

When a scheduled task is about to be executed, the program will display a warning message in the
lower right hand corner of the screen. This will allow the user to cancel the task if required by clicking
the stop button. The warning dialog is shown below:

Please note that the download time is no longer governed by the 11am automatic housekeeping time
in the MicroMarque3S. Therefore, downloads can be carried out at any time apart from during milkings. 
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9 Creating New Cow Records
New cow records can be created by either manually entering, importing from Cowculator for DOS or
Cowculator for Windows, or by downloading from the MicroMarque3S. 

9.1 Manually Entering Cow Records

The Create New Cow(s)  dialog is  used to create new cows in  ATL Cowculator.   The dialog can be

accessed by clicking the 'Create a New Cow' button on the tool bar  or the 'Create a New Cow' item
on the 'Edit' menu. See Chapter 4 for more information on the edit menu.

With this dialog the user can enter the bare minimum for creating a cow. When the Add button is
pressed the program will create the new cow with the brand number entered. If the “Add more than
one new cow” checkbox is checked the dialog will allow the user to create multiple cows, otherwise; it
will close and show the “Cow Information” screen for the new cow. See Chapter 20 for more information
on entering additional information available on the animal record.

9.2 Importing from Cowculator for DOS or Cowculator for Windows

ATL Cowculator can import data from different programs. The currently supported file formats are:

● ATL Cowculator for DOS

● ATL Tag Data Disks

● NMR DataStream Disks

The import wizard is shown below;
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To import data the user needs to select the file type, then locate the file with the browse button, and
finally click the Import button to perform the import.

When  importing  data  from  the  ATL  Cowculator  for  DOS  program,  you  can  specify  how  the  old
program's  flags are used by the new ATL Cowculator  program, See Chapter  8,  section 5 for  more
information.

9.3 Uploading (sending) to and Downloading (getting) from ATL controls

When  the  program  is  connected  to  the  MicroMarque3S  or  running  in  stand-alone  mode  when
connected to the MicroMarque4. The user will need to use the 'Send to' and 'Get from' commands. 

9.3.1 Uploading (Sending) to ATL Controls

To 'Send to' the controls which are setup on the system, click the send button  or select the Send
item from the 'File' menu. The communications dialog is shown below.

Click the 'Upload' button to send all data, or click 'Cancel' to close and abort the operation.

9.3.2 Downloading (Getting) from ATL Controls

The 'Get from' function is much the same. Use the 'Get from' button on the tool bar  or the Get
menu item on the 'File' menu to initiate the download. The Get communications dialog is shown below.

Click the 'Download' button to send all data, or click 'Cancel' to close and abort the operation.
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9.3.3 The Upload (Send) or Download (Get) Progress Bar

When a Get or Send is initiated the progress bar shows the overall progress of the task.

9.3.4 Uploading (Sending) and Downloading (Getting) from Multiple Controls

If the ATL Cowculator program is setup to be connected to an in parlour control as well as an out of
parlour control, the program will ask the user to select which control to Get or Send data to, the dialog
is shown below.

9.3.5 Updating the Time on the MicroMarque3S

If the time on the ATL MicroMarque3s control is incorrect, the program will warn the user with the Time
Error dialog. This will allow the user to correct the time to make sure the house keeping is performed at
the correct time. The dialog is shown below.

Please note that the time can only be changed using this function when the MicroMarque3S software is 
v4.32 or above.
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10 Changing Multiple Animal Records using Cow Operations
The Cow Operations dialog ican be used to change information in multiple animals records in one go. 

The user can either manually select cows in the list view, select an entire group for modification, or use

the select button   to load the Search dialog and perform a search for the animals which are
required. Below is a screen shot of the dialog;

10.1 Changing an Attention Flag

This routine allows the user to change the attention flags set against one or more cows. The attention
flags can be turned off, turned on, changed to one shot or date bound. The following attention flags
can be changed.

Artificial Insemination Bulling Foot Attention* High Cell Count*

Hold Milk* Mastitis Back Left* Mastitis Back Right* Mastitis

Mastitis Front Left* Mastitis Front Right* Slow Milker Test Milk

Three Quarter Cow Back
Left*

Three Quarter Cow Back
Right*

Three Quarter Cow Front
Left*

Three Quarter Cow Front
Right*

Veterinary Attention - - -
* Only available on MicroMarque4 system.

10.2 Changing a Numeric Value

This routine allows the user to change the numeric values associated with certain fields against one or
more animals. The numeric values can be changed, an amount can be added to the value, an amount
can be taken away from the value, a percentage can be added or a percentage can be taken away. The
following numeric values can be changed.
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Current Heat Cycle
Number

Number of Pregnancies Lactation Number Out of Parlour Feed A
Daily Ration

Out of Parlour Feed B
Daily Ration

In Parlour Feed Daily
Ration

Previous In Parlour Feed
Daily Ration

Lactation Total

10.3 Changing a Date Value

This routine allows the user to change the dates associated with certain fields against one or more
animals. The following dates can be changed.

Current Status Date Current Heat Cycle Start
Date

Previous Heat Cycle
Start Date

Calving Date

Service Date Drying Off Date Dry Date Steaming Up Date

Birth Date - - -

10.4 Changing the Group of Selected Animals

This routine allows the user to move animals from one group to another in one easy function. Animals
of any of the 24 groups can be moved to another group.
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11 The Brand Options Dialog
The Brand Options dialog allows the user to move an electronic identification number between two
animals.  The Brand Options dialog can be found by clicking on Edit on the Main Menu bar, and then
Brand Options.

The Brand Options dialog can be used when a reusable electronic ear tag is removed from one animal
and placed in a new animal, or when an animal's brand number has been wrongly entered into the
system and information needs to be preserved. The dialog can be seen below;
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12 Deleting Cow Records
There are two ways to delete animal records from ATL Cowculator 2010. The Delete Cow(s) dialog, the
red cross on the toolbar, can be used.  Both methods give options to delete either single or multiple
animals from the program.

12.1 Deleting Cows using the Delete Cow(s) Dialog

The Delete Cow(s) dialog can be found by clicking on Edit on the Main Menu bar, and then on Delete
Cow(s) .  

The dialog provides 3 options for deleting cows. These are:

• Delete a Single Cow - This lets the user choose an animal to be deleted.

• Delete all the Cows in a Group - This lets the user choose a group of animals to be deleted.

• Delete all the Cows in the Herd - This lets the user delete all the animals in the herd.

Please note than when ATL Cowculator is connected to the MicroMarque4 the “Mark Cows for deletion
on send to MicroMarque3S only” check-box is not be visible. The check-box allows the user to mark the
animals for deletion in the MicroMarque3S when communications is initiated. When the check box is
unchecked the program will delete the animals only from ATL Cowculator 2010.

12.2 Delete Animals using the Red Cross on the Toolbar

The Delete Cow button  on the toolbar deletes the currently highlighted animal or animals. When
the Delete Cow button is pressed the following dialog box appears. Click Yes to delete the selected
animal(s) or No to return to the previous screen.
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13 The Cow Information Screen
The cow information screen shows a list  of  all  animal  records stored in ATL Cowculator 2010.  The
default screen shows the cow number, status, group, birth date, national animal number and electronic
identification number. The list can be filtered to show only heat detection, pregnancy diagnosis, calving,
young stock, barren stock or deceased stock. This can be done by clicking on the relevant link on the
'view' list on the left-hand side of the screen.

List View 

Filter

Cow 

Information

If the user highlights and right-clicks on the animal's row, a box will appear, allowing the user to change
the following:

• Edit Status Information - Changes the animal's status (i.e. calved, in heat etc).

• Edit Feeding Information - Opens the Feed Tab for highlighted animal.

• Show Milk Yield Information - Opens the Milk Yield Tab for highlighted animal.

• Edit Drafting Information - Opens the Drafting Tab for highlighted animal.

• Family Tree – Open the Family Tree tab for the highlighted animal.

• Copy Selected Rows - Copies highlighted rows to clipboard for pasting into spreadsheet.

• Copy All Rows - Copies all rows to clipboard for pasting into spreadsheet.

• Select All Rows – Selects all rows in the current view.

13.1 Changing the Animal's Group

One or more animals can have their group changed using the Change group button on the navigation
bar.
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13.2 Changing the Animal's Status

One or more animals can have their status updated (i.e. calved, barren etc) using the Change Status
button on the Navigation bar.

There are 11 status's available. These are:

Young Stock Barren In Heat Served

Pregnant Aborted Calved Drying Off

Dry Unknown Deceased -

13.2.1 Changing the Animals Status to Calved

If the status is set to calved, the Calving Date Update screen will appear, and allow the user to decide
which totals to reset, whether to begin a new lactation curve or set the calving date.

Offspring

• Enter Offspring Information – When ticked allows you to enter information on the offspring. See
overleaf for more information.

Status

• Set the Cows Status to Calved - When ticked changes the animals status to calved.

• Set the Cows Status to Aborted – When ticked changes the animals status to aborted.

• Set the Cows Calving Date to - Select the date the animal calved.
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Milking

• Reset the Total Milk Yield to Zero - When ticked resets the total milk yield to zero for the new
lactation. 

• Clear Milk Hold Flag - When ticked clears the hold milk flag.

• Increment the Lactation Number - When ticked increments the lactation number by 1.

• Begin a New Lactation Curve - When ticked starts a new lactation curve.

Feeding

• Reset the Total In Parlour Feed to Zero - When ticked resets the in parlour feed total to zero for
the new lactation.

• Reset the Total Out of Parlour Feed to Zero - When ticked resets the out of parlour feed total to
zero for the new lactation.

13.2.2 Entering Offspring Information

• Number of Offspring – Select the number of offspring born. Use arrows to increase or decrease 
the number of offspring.

• Ease of Labour – Use the drop down menu to select the ease of labour.

Offspring Information

• Sex – Select the sex of the offspring.

• Offspring is Alive – When ticked states that the offspring is alive.

• Keep in Herd – When ticked animal is added to the herd.

• Brand Number – Enter the brand number of the newborn animal.

• National Animal Number – Enter the national animal number of the newborn animal.

• Name – Enter the name of the newborn animal.
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14 The Cow Calendar
The breeding calendar shows at a glance the current state of management of the herd. The calendar is
circular with animals displayed as colour coded circles, showing which are due to calve, due for service,
pregnancy diagnosis and drying off. This highlights animal's with irregular heat cycles and also gives an
overview of the calving pattern throughout the year.

Calendar View

Cow 

Information

14.1 How the Cow Calendar Works

The breeding calendar is split into 12 segments, each representing a month of the year. These segments
are further split into days in the month. Over the 12 months, the calendar is split into 9 sections, each
representing different periods of the cows calving cycle. The sections are as follows:

• Black pointer - Today's date

• Green pointer - First, second and third heats

• Pink pointer - First service

• Red pointer - Pregnancy diagnosis

• Orange pointer - Drying off

• Yellow pointer - Dry

• Blue pointer - Steaming up (if steaming up disabled, blue pointer will not be displayed)

The calendar rotates in a clockwise direction. When a particular pointer reaches a particular animal, the
action represented by the colour of the pointer is taken on that animal.

The following is an example of how the system works:

18th September - A cow is freshly calved. The cows status is changed to Calved and the colour of the
circle will change to black.
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7th October - Look for first heat, usually 21 days after calving. When you sees signs of the first heat,
change the cows status to In Heat and the colour of the circle will change to green.

28th October - Look for signs of the second heat.

18th November - Look for signs of the third heat.

10th December - If the cow is served, the status should be changed to Served and the colour of the
circle will change to pink. The status will automatically change to red if the cow's status is changed to
served for a second time.

5th February - Pregnancy diagnosis. If confirmed, the status should be changed to Pregnant and the
colour of the circle will change to purple.

26th July - Drying off period starts. The status should be changed to Drying Off and the colour of the
circle will change to orange.

8th August - Dry period starts. The status should be changed to Dry and the colour of the circle will
change to yellow.

8th September - Steaming up. The status should be changed to Steaming Up and the colour of the
circle will change to blue.

8th October - Calf due today. If calved, the status should be changed to Calved, the colour changed to
black and the process started over again.

14.2 Displaying Individual Cow Information

The user can single left-click on a cow's circle and information on that particular cow will be displayed 
as shown below. If the user double left-clicks, the cow record will open.
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15 The Milking Screen
The milking screen shows a list of the animals and their milk yield for the current day. The screen also
shows the predicted daily yield, deviation, lactation total and days in milk. The list can be filtered to
show current milk yield, last 30 milk yields, dated milk yields, production rates (calculated millilitres of
milk produced per minute between milkings), hold milk and slow milker cows.

Filter

Milking

It  should  be  noted  that  milk  yields  will  only  automatically  be  available  for  each  milking  if  the
MicroMarque3S control is connected to either ATL Micro Milk Meters or our competitors milk meters
via  a  Milk  Meter  Interface  and  the  data  from  the  MicroMarque3S  is  uploaded  each  day.  The
MicroMarque3S only stores 4 milking yields and therefore it is recommended uploading is set up as a
scheduled task each day to avoid losing yields.

15.1 Manually entering Milk Yields

Milk yields can be manually entered using the Enter a Milk Yield button in the Navigation menu. If a
milk yield is entered manually, the following window will be displayed.

The  stall  number,  milk  yield,  date  and  time  can  be  entered.  The  program  will  then  calculate  the
production rate and whether the milk yield deviation has been met.
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15.2 Todays and Yesterdays Daily Yield Totals

On the main milking screen, the milk yields shown in the Todays Daily Yield and Yesterdays Daily Yield
are dependent upon the Daily Milk Pickup Time chosen in the Cowculator Settings. See Chapter 7 for
more information.

Today's Daily 

Yield (litres)

Yesterdays 

Daily Yield (litres)
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16 The Feeding Screen
The  feeding  screen shows a  list  of  cows and  their  daily  in  parlour  feed and total  parlour  feed in
kilograms.  The  view can  be  changed to  show rations  with  milk  yields,  out  of  parlour  rations  with
uneaten feed (including 3 day average uneaten feed and the number of visits), out of parlour attentions,
and drying off and steaming up dates.

Change 

Rations

Ration

Calculations

Filters

Feeding

The user can change both in parlour and out of parlour feed rations either manually or calculate them
using either a feed table, feed to yield or days in milk.

16.1 Manually changing In Parlour Daily Feed Rations

The user can manually change the daily ration using the Edit In parlour Feed button on the navigation
menu. The dialog box shown above is displayed. This shows the daily feed ration in kilograms, and is
divided between the number of milkings per day. Therefore, if a daily ration of 3kg is chosen for a cow,
on twice a day milking, the cow would get 1.5kg per milking, and on three times a day milking, the cow
would get 1.0kg per milking.

IMPORTANT - For the ration change to take effect, a download to the Micro Marque 3S will have to be
carried out. On Micro Marque 4 systems, the data is live and therefore no download is required for the
changes to take effect.
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16.2 Manually changing Out of Parlour Daily Feed Rations

The  user  can  manually  change  the daily  ration using  the Edit  Out  of  parlour  Feed button  on the
navigation menu. The dialog box shown above is displayed.

IMPORTANT - For the ration change to take effect, a download to the Out of Parlour Control will have
to be carried out. 

16.3 Using Ration Calculations to automatically change Daily Feed Rations

Daily feed rations can be automatically calculated using the Calculate Rations button on the navigation
menu. The dialog box allows the user to perform ration calculations for all cows, for cows currently in
the list view, or only for currently highlighted cows.

It should be noted that the ration calculations need to be set up prior to clicking upon this button.
Please see Chapter 21 for more information.

It should also be noted that this process can be automated using Scheduled Tasks in the Settings menu.
Please see Chapter 7 for more information.

53



                  Innovation In and Out of Parlour ATL Cowculator 2010 - User Guide

17 The Drafting Screen
The drafting screen shows a list of animals and the attention / warning flags that are set against them
which can be used for drafting. There are two views depending on which parlour control is connected to
ATL Cowculator 2010.

17.1 The MicroMarque3S View

The view for the ATL Micro Marque 3s is shown below.

Set Flags

Filter

Drafting

The tick boxes can be quickly ticked to draft an animal through either one or two drafting gate systems
using any one of the 7 attention flags used for drafting by the MicroMarque3S. 

Highlight one or more animals in the list view and click on any of the links in the navigation bar on the
left-hand side of the screen to set attention flags at the click of a button. Attentions can be set for
artificial insemination, veterinary attention, mastitis, test, bulling or slow milkers using this method.

The last seen by drafting gate shows the time stamp when the animals electronic tag was last read by
the drafting gate system.

The missing cows filter  in  the navigation menu displays animals  which have not  been seen by the
drafting gate system for more than 24 hours.

54



                  Innovation In and Out of Parlour ATL Cowculator 2010 - User Guide

17.2 The MicroMarque4 View

The view for the ATL Micro Marque 4 is shown below.

Set Drafting

Filter

Drafting

The tick boxes can be quickly ticked to draft an animal through either one or two drafting gate systems
using any one of the 4 dedicated sorting/drafting flags used for drafting by the MicroMarque4. 

Highlight one or more animals in the list view and click on any of the links in the navigation bar on the
left-hand side of the screen to set attention flags at the click of a button. Attentions can be set for sort
first left, sort first right, sort second left and sort second right using this method.

The last seen by drafting gate shows the time stamp when the animals electronic tag was last read by
the drafting gate system.

The missing animals filter in the navigation menu displays animals which have not been seen by the
drafting gate system for more than 24 hours.
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18 The Health Screen
The health screen shows a list  of animals  and the health attentions that are set against  them. The
default view includes the health attentions high cell count, hold antibiotic milk, mastitis, three quarter
cow, test milk, veterinary attention and foot attention. Other views are available highlighting mastitis
quarter and three quarter cows only.

Filter

Health

Buttons are available in the navigation bar to quickly set mastitis attentions on either the front left, front
right, back left and back right quarters for highlighted animals. The clear mastitis button can be used to
remove all mastitis attentions set and the toggle test milk flag turns the test milk flag on and off against
highlighted animals. 

18.1 Adding and Removing Medicines

The user can record medicine use against individual animals from within the health screen. Before this
can happen, medicines must be added to the medicine editor. The medicine editor has three views -
show all medicines, show only those medicines in date and show only those medicines deleted. 

Click  on the  Add button  to  add a  new batch  of  medicine  to  the  medicines  editor.  The  following
information is required when adding a new medicine to the Medicines Editor:

• Medicine name and description

• Batch number

• Purchase date

• Expiry date

• Quantity

• Hold milk option and how long to hold milk
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The Medicine Editor is shown below:

The add a new medicine dialog box is shown below:

57



                  Innovation In and Out of Parlour ATL Cowculator 2010 - User Guide

18.2 Administering a Medicine Dose

The user can click the Administer Medicine Dose button  to apply a dose of medicine to an animal.
The dialog is shown below;

The dialog requires the user to input the name of the person who administered the dose, the medicine,
the date and the amount given. The user can also add a note to the treatment and the Info field will
display any extra information in relation to the dose.
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19 Editing Attention / Warning Flags
From any of the list views where attention / warning flags are displayed, the user can double click on an
attention / warning flag. The Change Warning Flag dialog will be displayed. The dialog is shown below.

The user can edit the following attention / warning flags to be Always On, Always Off, One Shot or Date
Bound.

Artificial
Insemination

Veterinary
Attention

Test Milk Hold Milk High Cell Count

Bulling Flag Foot Attention Sort First left Sort First Right Sort Second Left

Sort Second Right Mastitis Front Left Mastitis Front Right Mastitis Back Left Mastitis Back Right

Three Quarter Cow
Front Left

Three Quarter Cow
Front Right

Three Quarter Cow
Back Left

Three Quarter Cow
Back Right

The following attention / warning flags can be edited to be Always On and Always Off.

Mastitss Slow Milker Flag Quick Sort

NB - Edited attentions / warning flags can only be displayed in the milking parlour on PC_based control
systems.
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20 The Cow Record
The Cow Record stores information on the individual animal such as position in the lactation cycle,
group, date of birth, lactation number, in parlour and out of parlour rations, milk yields and drafting
information. To get to an animal's record, double click on the cow number in the list view. The tabs
available in the cow editor are: Status, Feeding, Milk Yields and Drafting. 

20.1 The Status Tab

The Status Tab is shown below. Status

This view allows the user to view and edit information related to the animal's status. This tab also shows
a  history  of  the  animal's  status  events.  These  can  be  clicked  on  to  view  the  event  information.
Information available on this tab is as follows:

• Status - The position of the animal in the lactation cycle or status of the animal - young stock,
barren,  in  heat,  served,  pregnant,  aborted,  calved,  drying  off,  dry,  steaming  up,  unknown,
deceased.

• Status Date - The date the status was last changed.

• Group - The group of the animal.
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• Previous Calving Date - The date of the previous calving.

• Date of Birth - The date the animal was born.

• Age - The age of the animal (years, months, days).

• Days in Milk - The number of days the animal has been in milk during this lactation.

• Number of Pregnancies - The number of pregnancies the animal has had.

• Lactation Number - The number of lactations the animal has had.

• Cow Name - The animal's name.

• Tag Code - The electronic ear tag (EID) code associated with the animal.

• Nat. An. Num. - The national animal number associated with the animal.

20.1.1 The Status Information Box

The Status Information box is a visual display of historical and predicted events shown on a time line
from the animal's birth. Below the time line, a list of the events is displayed in order of occurrence. 

Historical events are represented by the following graphics:

Status Indicator Graphical Representation

Status Changed

Foot Treatment

Medicine Treatment

Mastitis Event

High Cell Count Event

Status Changed to Barren

Status Changed to Deceased

Three Quarter Cow

Abortion Event

Predicted events are represented by the following graphics:

Predicted Status Indicator Graphical Representation

First Heat Due
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Predicted Status Indicator Graphical Representation

Next Heat Due

Pregnancy Diagnosis Due

Drying Off Due

Dry Due

Steaming Up Due

Next Calving Due
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20.2 The Feeding Tab

The Feeding tab shows information related to the individual rations provided by the in parlour and out
of parlour feeding systems. The Feeding Tab is split into three sub-tabs - In Parlour Feed History, Out of
Parlour Feed History and Feed Split. 

20.2.1 The In Parlour Feed History Tab

The In Parlour Feed History tab is shown below. 

This  tab monitors the individual  animal's  milk  production against  the amount  of feed eaten in  the
milking parlour. Please note that this does not include out of parlour feed. The milk yield totals are true
daily totals and are NOT dependent upon the Daily Milk Pickup Time chosen in the Cowculator Settings.
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20.2.2 The Out of Parlour Feed History Tab

The Out of Parlour Feed History tab allows the user to view feed intake by the cow from the out of
parlour feeding system. The tab page is shown below.

The Feeding tab page also includes information on the visit and feeding averages for the cow. This
allows the user to quickly spot a cow which is not feeding correctly and may have health problems.

Mouse over the bar chart to see the date and either the total out of parlour ration or the amount of
eaten and uneaten feed in kilograms. 

20.2.3 The Feed Split Tab

The Feed Split tab shows the user a pie chart of the cow's total daily feed ration and the split between in
parlour and out of parlour feeding systems.

Mouse over each part of the pie chart to see the amount of feed in kilograms and the percentage of the
daily feed ration. 

In the above pie chart,  Feed A, in green,  represents out of parlour feed, and equates to 4.00kg or
70.43% of the daily feed ration, and In Parlour, in blue, equates to 1.68kg or 29.57% of the daily feed
ration.
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20.2.4 The In Parlour and Out of Parlour Feed Boxes

On all three of the sub-tabs there are two boxes displaying information on in parlour and out of parlour
feeding. 

The In Parlour Feed Box displays the following information:

• In Parlour Feed - The current daily in parlour feed ration in kilograms (kg). This can be user set 
here, automatically updated using ration calculations or changed for one or more cows using 
the Cow Operations dialog. See Chapter 9.

• Total Feed Ration - The total in parlour feed provided to the cow. This can be reset to zero when
the status is changed to calved - therefore, if reset to zero for each new lactation, will represent
feed for lactation, otherwise will represent feed for cow's lifetime.

• Daily Feed Ration - The total in parlour and out of parlour feed ration in kilograms (kg).

The Out of Parlour Feed Box displays the following information:

• Feed A - The current daily out of parlour feed A ration in kilograms (kg). This can be user set 
here, automatically updated using ration calculations or changed for one or more cows using 
the Cow Operations dialog. See Chapter 9.

• Total Out of Parlour Feed A - The total out of parlour feed provided to the cow over it's lifetime.

• Visits - The number of visits the cow has made to the out of parlour feeding system during the 
last complete 24 hour cycle (for last download).

• Average Visits - The average number of visits the cow has made to the out of parlour feeding
system per complete 24 hour cycle in it's lifetime.

• 3 Day Average Visits - The average number of visits the cow has made to the out of parlour
feeding system per complete 24 hour cycle in the last 3 days. The number of days the average is
taken over can be changed in the Cowculator settings. See Chapter 7.

• Uneaten Feed A - The current amount of uneaten Feed A that the cow has left  during the
previous complete 24 hour cycle.

• Average Uneaten Feed A - The average amount of uneaten Feed A that the cow has left over it's
lifetime.

• 3 Day Average Uneaten Feed A - The average amount of uneaten Feed A that the cow has left
over the previous 3 complete 24 hour cycles. The number of days the average is taken over can
be changed in the Cowculator settings. See Chapter 7.

• Total Time Spent in a Stall – The total time that the cow was standing in a stall over previous 24
hour cycle. Requires the out of parlour control unit to have v2.07 or above software.

• Average Total Time Spent in a Stall – The average total time that the cow was standing in a stall
over the feed history of the animal. Requires the out of parlour control unit to have v2.07 or
above software.

• 3 Day Average Total Time Spent in a Stall - The average total time that the cow was standing in
a stall over the previous 3 complete 24 hour cycles. Requires the out of parlour control unit to
have v2.07 or above software. The number of days the average is taken over can be changed in
the Cowculator settings. See Chapter 7.
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20.3 The Milk Yields Tab

The Milk Yields tab contains a line graph showing the milk yields in litres (l) for each milking, as well as
the total daily  yield,  also in litres (l),  and the production rate in millilitres per minute (ml/min).  The
production rate is the amount of milk the animal produces per minute between each milking. This is
used to calculate the predicted daily yield, which provides an indication of whether an animal has met
her production rate, and if she has not, can provide an indication of possible health problems. 

The Select Plots button in the top right-hand corner of the graph opens the Select Milk Yield Plots
dialog and allows the user to choose the information displayed on the graph. The Daily Milk Yield totals
shown on the graph are are dependent upon the Daily Milk Pickup Time chosen in the Cowculator
Settings. See Chapter 7 for more information.

The midday yield is only 
available if 3 times a day
milking is selected in the 
Cowculator settings. See
Chapter 7.
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20.3.1 Comparing Lactation Curves

The Select Curve button in the top right-hand corner of the graph opens the Select Lactation Curve
dialog and allows the user to choose the lactation curve displayed on the graph. Multiple lactation
curves can be selected to assess animal performance by holding down the shift button and clicking on
two or more lactation curves.

If more than one lactation curve is selected, the Curve Values displays information from each of the
lactation curves so that animal performance can be compared quickly and easily. Each lactation curve is
numbered individually - Curve 1, Curve 2 etc.
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20.3.2 The Milk Yield Information Box

The Milk Yield Information Box provides information on the current milk yields, as well as the current
lactation curve and previous lactation curves for comparison.

The Current Milk Yield displays the following information:

• Todays Milk Yield - The animal's daily milk yield in litres (l) for today.  This value is dependent
upon the Daily Milk Pickup Time chosen in the Cowculator Settings. See Chapter 7 for more
information.

• Yesterdays  Milk  Yield  -  The animal's  daily  milk  yield  in  litres  (l)  for  yesterday.  This  value  is
dependent upon the Daily Milk Pickup Time chosen in the Cowculator Settings. See Chapter 7
for more information.

• Predicted Daily Milk Yield - The predicted daily yield, calculated using the animal's production
rate.

• Newest Recording - The yield recorded from the previous milking in litres (l).

• Newest Recording Time Stamp - The date and time of the last milk recording. Please note that
on MicroMarque3S systems, the time stamp is the same for all  animals and is set when the
Micro Wash Control is put into milking mode. On MicroMarque4 systems, it is set when the
milking button is pressed on the Micro Milk Meter control and is therefore different for each
animal.

• Newest Recording Stall Number - The stall number the animal was last milked at. Please note
this is only available on the MicroMarque4.

• Newest Recording Length - The time taken for to milk  the animal.  Please note this is  only
available on the MicroMarque4.

• Newest Production Rate - The production rate for the previous milking in millilitres per minute
(ml / min). 

• Newest  Average  Production  Rate  -  The  average  production  rate  over  the  last  14  days  in
millilitres per minute (ml / min).

• Newest  Deviation -  The deviation  from the average production rate in  litres  (l)  for  the last
milking.

• Newest Deviation Percentage - The percentage deviation from the average production rate for
the previous milk recording.

• Newest Low Yield Flag - If the milk yield deviation for this animal has not been met during the
previous milking (i.e. the animal has not given enough milk), then this flag is set.

The Curve Values displays the following information:

• 100 Day Lactation Total – The total milk produced by the animal during the first 100 days of the
current lactation (l).

• 6 Month Lactation Total - The total milk produced by the animal during the first 6 months of the
current lactation (l).

• 12 Month Lactation Total - The total milk produced by the animal during the first 12 months of
the current lactation (l).
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• Lactation Total - The total milk produced by the animal during the current lactation in litres (l).

• Number of Milkings  -  The total  number of  milk  yield recordings for this  animal  during the
current lactation.

• Average Production Rates - The average production rate for the current lactation in millilitres
per minute (ml / min).

• Average Daily Yields - The average daily yield for the current lactation in litres (l).

• Average Milking Length - The average milking length in minutes and seconds for the current
lactation. Please note that this is only available on the MicroMarque4.

• Number of Low Yield Flags - The number of low yield flags set during the current lactation.
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20.4 The Drafting Tab

The Drafting tab allows the user to edit when drafting flags come on and go off. The view has two 
versions, depending on the parlour control connected.

20.4.1 The MicroMarque3S View

The view for the ATL Micro Marque 3s is shown below.

The view the attention flags that are currently set against the selected animal. The attention flags are
used by the drafting system to sort out animals. The following options are available:

• Always Off - The attention is always off.

• Always On - The attention is on until the user turns it off.

• One Shot - The attention is on for one milking. When the animal is identified by the drafting
system, it will be drafted / sorted once and then the attention will be automatically removed.

• Date Bound - The attention is on for the period selected by the user. Before and after this,
unless the user turns the attention on, the attention will be off. NB – Requires Cowculator to
send data to MicroMarque3S every day to function correctly.
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20.4.2 The MicroMarque4 View

The ATL MicroMarque4 Drafting tab is shown below. This view differs from the MicroMarque3S because
the MicroMarque4 has dedicated sorting flags.

The view shows the user the drafting settings that are currently set against the selected animal. The
drafting settings are used by the drafting system to sort out animals. The drafting flags available are
sort first  left,  sort first  right,  sort  second left,  sort  second right,  quick sort  and group drafting.  The
following options are available:

• Always Off - The attention is always off.

• Always On - The attention is on until the user turns it off.

• One Shot - The attention is on for one milking. When the animal is identified by the drafting
system, it will be drafted / sorted once and then the attention will be automatically removed. 

• Date Bound - The attention is on for the period selected by the user. Before and after this,
unless the user turns the attention on, the attention will be off. 
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20.4.3 Group Drafting

Group drafting  is  only  available  with  the  MicroMarque4  and  allows  the  user  to  automatically  sort
animals by group. Therefore, the high yielders could automatically be split from the rest of the herd
after the milking so they can be given more feed. Group drafting can be turned on or off in the Groups
dialog box. Please see Chapter 20 for more information on group drafting.

20.4.4 The Mark Cows for Drafting Dialog

The Mark Cows for Drafting dialog allows users to select multiple animals from the main list of animals
and  draft  them through the  desired drafting  gates.  The  dialog  has  two  versions,  one for  the  ATL
MicroMarque3s and one for the ATL MicroMarque4.

The ATL Micro Marque 3s version is shown below;

The ATL Micro Marque 4 version is shown below;

The Reset all other drafting flags check box allows the user to clear all other drafting flags which are set
against that animal, so that the desired drafting function is achieved. Multiple animals can be selected
by holding down the Ctrl key and clicking on the cows.
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20.5 The Family Tree Tab

The family tree tab allows the user to view the lineage of the animals in the herd. The tab can bee seen 
below;

The user can use the zoom buttons to see the whole tree, and zoom in on individual animals.
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21 Groups
There are 24 groups available for use and they can contain as many animals as the user requires. The
name of each group can be changed by the user and each group can be configured to link to any one
of the rations calculations available from the ration calculations menu. The groups dialog box can be
found by clicking on the Settings on the main menu bar, and then Groups.

21.1 Creating Groups

The  Edit  Group  Information  dialog  is  used  to  edit  the  group  name,  change  the  ration  calculation
method, change the ration split between in parlour and out of parlour feeding, and, if a MicroMarque4
is connected, set up group drafting.  

The user can name each group to make it more obvious what the group is for or for identification of the
cows in the group.

21.2 Group Ration Calculations

The user can specify, for each of the 24 groups, whether the group will have rations calculated for it. The
user can select from the two options to control how rations are calculated.

• Disabled - This option disables ration calculations for this entire group.

• Enabled - This option enables the ration calculations for this entire group. The user will then
need to select the method to calculate rations by. This is done by clicking the “Change Method”
button. For more information on ration calculations, please see Chapter 21.
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21.3 Group Ration Calculation Split

Once the ration calculation method has been selected, the user can select how the calculated ration is
allocated to an animal in the group from the ration calculation split tab as shown overleaf.

There are 5 options for splitting the calculated ration:

• Calculate rations for the in parlour control only - The whole ration will be allocated to the in
parlour feeding system.

• Calculate rations for the out of parlour control only - The whole ration will be allocated to the
out of parlour feeding system.

• Percentage based split between in parlour and out of parlour - This method allows the user to
set  a  percentage  split  for  the  calculated  ration  between the  in  parlour  and  out  of  parlour
feeding systems.

• Fixed out of parlour , calculated in parlour - This method allows the user to specify a fixed ration
for the out of parlour feeding system and have the remaining calculated feed allocated to the in
parlour feeding system.

• Fixed in parlour , calculated out of parlour - This method allows the user to specify a fixed ration
for the in parlour feeding system and have the remaining calculated feed allocated to the out of
parlour feeding system.
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21.4 Group Drafting

The final tab page of the Edit Groups dialog contains group drafting settings.

The settings allow the user to enable group drafting in the ATL MicroMarque4. Please note this function
is only available in the ATL MicroMarque4.
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22 Ration Calculations
There are three methods of calculating rations available in ATL Cowculator 2010. These are as follows:

• Feed Table - Simple feeding 

• Feed to Yield - Feeding based upon individual milk yields

• Ration Curve - Feeding based upon days in milk

The feed table and feed to yield ration calculations require milk yield information in order for them to
be carried out. Milk yield information can be obtained via manual entry (see Chapter 14), from the ATL
Micro Milk Meter system or from a Milk Meter Interface linked to a competitors milk meter system. Milk
yields can also be imported from NMR Datastream discs and the CIS equivalent. For information on
feed tables and for information on feed to yield please see Chapter 16.

The ration curve calculates rations based upon the number of days a cow has been in milk and does not
require milk yields.  For information on ration curves please see Chapter 16.

22.1 Creating and Selecting Ration Calculations

Ration calculations can be created and/or selected in one of two ways. By clicking on Settings on the
Main Menu bar, and then Ration Calculations, or by clicking the Change Method button in the Groups
dialog box,

The Ration Calculation dialog box is shown below.

The user can create, edit or select a ration calculation. If the user has arrived here from the Groups
dialog box, a ration calculation can be assigned to that group.
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22.2 Feed Tables

A feed table is a very simple way to allocate rations to the herd based on milking performance. The
Feed Table Editor can bee seen below:

The ration calculation uses the milk yield source value to set a feed ration for each cow. Using the table
above as an example, a cow that produces between 12 and 15 litres of milk will receive a ration of 4.00
kilograms (kg)  and  a  cow which products  more than 20 litres  of  milk  will  receive  a  ration of  6.00
kilograms (kg) of feed. 

Click Add Row to add a row , Edit Row to edit a row and Delete Row to delete a row from the feed table.

The milk yield source value is chosen in the Cowculator Settings (see Chapter 7 for more information)
and can be one of the following:

• Yesterdays Daily Milk Yield - The daily milk yield recorded yesterday.

• Average Daily Yield - The average daily milk yield over a selectable number of days.

• Predicted Daily Yield - The calculated predicted daily yield using the production rate.
This is the average production rate over the last 14 days.

• Newest Recording – The newest recording. This setting is only recommended for users
using the NMR DataStream import facility.

Using the following milk yields as an example, the ration calculations would be.

Day Daily Milk Yield Predicted Daily Milk Yield

Wednesday 20.5 litres 20.3 litres

Thursday 19.3 litres 19.8 litres

Friday 20.1 litres 20.4 litres

Saturday 19.8 litres 19.9 litres

Sunday 20.5 litres 20.3 litres
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Monday 19.3 litres 19.8 litres

Yesterday 20.1 litres 20.4 litres

Example 1 - If yesterday a cow produced a milk yield of 20.1 litres (l), based upon the feed table shown
in the picture on the previous page, the cow would receive 6.0 kilograms (kg) of feed today, if a ration
calculation was carried out prior to today's morning milking. 

Example 2 - If over the last 7 days a cow produced an average milk yield of 19.9 litres (l), based upon
the feed table shown in the picture on the previous page, the cow would receive 5.0 kilograms (kg) of
feed today, if a ration calculation was carried out prior to today's morning milking. 

Example 3 - If the predicted milk yield is 20.4 litres (l), based upon the feed table shown in the picture
on the previous page, the cow would receive 6.0 kilograms (kg) of feed today, if the ration calculation
was carried out prior to today's morning milking. 

22.3 Feed to Yield

The feed to yield calculation is very simple, with the feed for a cow calculated using the amount of milk
the cow is producing. The calculation is shown in the image below.

The ration calculation uses the milk yield source value and produces a feed ration for each cow based
upon the following calculation:

Ration = (Milk Yield Value - Maintenance Plus Value) x Concentrate Rate 

The milk yield source value is chosen in the Cowculator Settings (see Chapter 7 for more information)
and can be one of the following:

• Yesterdays Daily Milk Yield - The daily milk yield recorded yesterday.

• Average Daily Yield - The average daily milk yield over a selectable number of days.

• Predicted Daily Yield - The calculated predicted daily yield using the production rate.
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This is the average production rate over the last 14 days.

• Newest Recording – The newest recording. This setting is only recommended for users
using the NMR DataStream import facility.

The following values are user set:

• Concentrate Rate - The concentrate rate is the amount of feed (in kilograms) that is required to
result in a milk yield increase of 1 litre. For bought in feed, the value should be available from
the supplier. For home mix, special analysis is recommended. Default = 0.5.

• Maintenance Plus - The maintenance plus value represents the amount of milk that the cow
would produce naturally without any additional protein. The actual value may vary according to
calving date and position in the lactation cycle. Default = 10.0 litres.

• Minimum Feed - The minimum amount of feed that will be provided as a ration. Default = 0kg.

• Maximum Feed - The maximum amount of feed that will be provided as a ration. Default =
10kg.

ATL Cowculator 2010 also allows the user to set limits on the increase or decrease of animals feed,
reducing the impact of any problems with milk yield recording. 

To do this, tick the Enable Maximum Feed Adjust box and set the maximum gain and maximum loss
settings.  As  a  default,  these  are  set  to  25% maximum gain  and  10% maximum loss.  If  the  ration
calculation provides a new value that is different by more than the maximum gain or loss value, the
ration will be set at a value equivalent to the maximum gain or loss value.

Using  the following milk  yields  as  an  example,  and  a  maintenance  plus  value  of  10.0  litres  and a
concentrate rate of 0.5, the ration calculations would be.

Day Daily Milk Yield Predicted Daily Milk Yield

Wednesday 20.5 litres 20.3 litres

Thursday 19.3 litres 19.8 litres

Friday 20.1 litres 20.4 litres

Saturday 19.8 litres 19.9 litres

Sunday 20.5 litres 20.3 litres

Monday 19.3 litres 19.8 litres

Yesterday 20.1 litres 20.4 litres

Example 1 -If yesterday a cow produced a milk yield of 20.1 litres (l), based upon the feed to yield
calculation the cow would receive 5.0 kilograms (kg) of feed today, if a ration calculation was carried out
prior to today's morning milking. 

Example 2 -If over the last 7 days a cow produced an average milk yield of 19.9 litres (l), based upon
the  feed  to  yield  calculation  the  cow  would  receive  4.9  kilograms  (kg)  of  feed  today,  if  a  ration
calculation was carried out prior to today's morning milking. 

Example 3 - If the predicted milk yield is 20.4 litres (l), based upon the feed to yield calculation, the cow
would receive 5.2 kilogram (kg) of feed today, if the ration calculation was carried out prior to today's
morning milking. 
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22.4 Ration Curve

The ration curve calculation allows users to create a feeding regime based upon the number of days a
cow has been in milk. The user decides the ration they would like to feed a cow after a certain number
of days in milk, adding as many points on the curve as required, and ATL Cowculator 2010 works out
the amount of feed to be fed between the entered points and changes the cows rations accordingly.

Click Add Leg to add a leg, click Edit Leg to edit a leg and click Delete Leg to delete a leg from the
ration curve.

Please note that for the rations to be changed, the ration calculation has to be run everyday and if on a
MicroMarque3S system, downloaded to the parlour control.

22.5 Calculating Rations

When the Calculate Rations function is initiated, either by clicking the calculate rations button  or by
selecting the 'Edit' menu and then clicking the Calculate Rations item, the Calculate Rations dialog is
shown below:
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The dialog allows the user to perform the ration calculations for all the cows, only the currently listed
cows in the list view, or only for the currently selected cows in the list view.

The ration calculation should be run as regularly as required. For example, if the ration curve calculation
is being used, then the ration calculation should be run everyday, in order for the rations to be up to
date. Ration calculations can be set to run automatically as a scheduled task, please see Chapter 7 for
more information.
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23 Herd Statistics
The Herd Statistics screen provides historical statistics on the herd. The statistics are split between three
tabs - milk yield totals, feed totals and herd totals. The statistics can be filtered to include only cows in
the list view using the radial buttons in the top left-hand corner of the screen.

23.1 Milk Yield Totals

The milk yield totals tab shows all the milk produced in either yearly, monthly or daily totals displayed
graphically. Milk yield totals are coloured blue on the graph.

For yearly totals, click on All Years in the navigation menu on the left-hand side. For monthly totals, click
on the year (i.e. 2010) and for daily totals, click on the month (i.e. March 2010). The user can mouse-
over the totals on all graphs to see the actual totals in litres.

Please  note  that  the  milk  yield  totals  will  only  show milk  yield  for  animals  that  have  been either
measured  using  the  ATL  Micro  Milk  Meter  or  a  competitors  milk  meter  connected  to  the
MicroMarque3S using the Milk Meter Interface. It does not include any milk that goes into the dump
line.

The milk yield totals are dependent upon the Daily Milk Pickup Time chosen in the Cowculator Settings.
See Chapter 7 for more information.

23.2 Feed Totals

The feed totals tab show all the feed used by the in parlour and out of parlour feeding systems in either
yearly, monthly or daily totals displayed graphically. Feed totals are coloured green on the graph.

The feed totals include rations fed through both in parlour and out of parlour feeding systems. If only
one type of feeding system is being used, the feed from that system will only be used within the totals.
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For yearly totals, click on All Years in the navigation menu on the left-hand side. For monthly totals, click
on the year (i.e. 2010) and for daily totals, click on the month (i.e. March 2010). The user can mouse-
over the totals on all graphs to see the actual totals in kilograms.

23.3 Herd Totals

The herd totals tab shows totals associated with various parts of the ATL Cowculator 2010 program.

The follwing totals are available on the Herd Totals tab:
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• Number of Cows - The total number of animals in the ATL Cowculator 2010 program.

• Cow Calvings by Month - This shows a month list with the number of animals which calved
during each month.

• Calendar Status - This shows the number of animals in each of the status groups. 

• Warnings - This shows the number of animals with each warning / attention.

• Cow with Yield Variations - This shows animals which have increased or decreased yields by the
percentage value. 

• Daily Feed Information - Shows various daily feed totals:

• Average In Parlour Feed - The average in parlour feed for the herd.

• Total In Parlour Daily Feed - The amount of feed allocated for all  cows in the In
Parlour feeding system.

• In Parlour Feed Used Today - The amount of In Parlour feed used today.

• Average Out of Parlour Feed A - The average value of feed for animals using the Out
of Parlour Feeder A.

• Average Out of Parlour Feed B - The average value of feed for animals using the Out
of Parlour Feeder B.

• Out of Parlour Feed Used Today - The Amount of Out of Parlour feed used today.

• Daily Yield Information - Shows various daily milk yield totals

• Average Yield - The average yield of the herd.

• Daily Yield - The daily yield of the herd.

• Group Totals

• Group number and name – The number of the group (0-23) and it's name.

• Number of animals – The total number of animals in the group.

• Daily yield – The total daily yield for all the animals in the group.

• Average daily yield – The average daily yield for all the animals in the group.
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24 Searching for Cows
Searching for cows can be carried out using either the quick find search box or more detailed searching.
Both methods are outlined below.

24.1 Using the Quick Find Search Box

The Quick Find Search Box allows the user to quickly type in an animal's number and have ATL 
Cowculator select and highlight that animal in the list, as show below;

When the animal number cannot be found, the box will turn red, as shown below;

If the user has moved the selected animal since the quick find was carried out, they can click the redo 
button next to the entry box to repeat the search and find the cow again.

Pressing enter after the animal is found will load the “Cow Information” screen.

24.2 Detailed Searching

The Search for Cows dialog, found on the edit menu, can be used to search recursively through the
animal list using the 'Search In Results' check box. Ticking the 'Search In Results' check box will make
the search algorithm only look at animals which have been previously found, or are currently listed from
a menu selection such as the Cow Filter menu item of the Organise menu.
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In a normal search, the previously completed searches are visible by clicking the down arrow on the end
of the 'For' entry box. Selecting one of these options will load it into the search dialog. To perform the
search simply click the 'Search' or 'Highlight' buttons, the difference being that the 'Search' button will
only show the animals searched for, and the 'Highlight' will highlight the searched cows in the list of
animals. The 'Clear Search' button will clear all filters and return a full list of all the animals. 

Clicking the '+' button next to the 'Options' will show the options, as the image below shows;
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The options area allows the user to specify that the searching will take place in the current list of cows,
therefore if a search has already been processed, the search will only look through those results. If the
user wants to change the colour of the highlight, this can be done by clicking the background colour
button.

The 'Close' button will close the dialog and return to the ATL Cowculator interface. 

When searching in a Warning Flag column, such as the Veterinary Attention column, there are multiple
choices for the conditions;The choices are as follows;

• IS EQUAL TO: this performs a search to return all the animals with the warning flag which is
equal to the value specified.

• HAS BEEN TRUE AFTER: this performs a search to find all the animals where the flag has been
true after a certain date.

• HAS NOT BEEN TRUE AFTER; this performs a search to find all the animals where the flag has
always been false after a certain date.

• HAS BEEN TRUE BEFORE: this performs a search to find all the animals where the flag has been
true before a certain date.

• HAS NOT BEEN TRUE BEFORE: this performs a search to find all the animals where the flag has
always been false before a certain date.

• HAS BEEN TRUE BETWEEN: this performs a search to find all the animals where the flag has
been true between two dates.

• HAS NOT BEEN TRUE BETWEEN: this performs a search to find all the animals where the flag has
always been false between two dates.

• Please Note: True means Flag On, False means Flag Off.

When performing normal numeric based searches the choices are as follows:

• IS EQUAL TO: this performs a search to return all the animals with the column item which is
equal to the value specified.

• IS GREATER THAN: this performs a search to return all the animals with the column item which is
greater than the value specified.

• IS LESS THAN: this performs a search to return all the animals with the column item which is less
than the value specified.
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• IS NOT EQUAL TO: this performs a search to return all the animals with the column item which is
NOT equal to the value specified.

When performing selection searches, such as searching for animals in a group; see below:

The only choices are to search using the IS EQUAL TO and IS NOT EQUAL TO conditions. This is also
true for any searches performed on text based columns, such as the Tag Number. When performing
searches on date time columns, such as the previous milk recording time stamp; See below:

The following conditions are allowed:

• IS EQUAL TO: this performs a search to return all the animals with the column item which is
equal to the date specified.

• IS AFTER: this performs a search to return all the animals with the column item which is after the
date specified.

• IS BEFORE: this performs a search to return all the animals with the column item which is before
the date specified.

• IS BETWEEN: this performs a search to return all  the animals with the column item which is
between the dates specified.

• HAS BEEN SET: this performs a search to return all the animals where this date has been set by
the user or by the system.

• HAS NOT BEEN SET: this performs a search to return all the animals where this date has not
been set by the user or by the system.
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24.3 The Highlight Button

Using the 'Highlight' button, the user can mark all the animals in the Cow List View which conform to
the search parameters. As shown below;

These marked animals are then shown  as 'marked' on the main animal listing view. The mark is shown 
as a coloured highlight of the row.
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25 Backing Up and Restoring Cow Data
ATL Cowculator 2010 includes a backup and restore feature to prevent data loss. The backup function is
accessed using the File menu on the Main Menu bar, and then by clicking on Backup Cow Data. This will
open a Save As file dialog, allowing the user to save the data file. 

This file can be restored using the Restore Cow Data menu item on the 'File' menu.

If the ATL Cowculator cow data is not backed up for over 14 days, the ATL Cowculator program will ask
the user to backup the data. The following dialog will be shown when exiting the ATL Cowculator 2010
program until a backup is performed.
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26 Reports
ATL Cowculator 2010 includes a report engine designed to create reports from the data stored in the
program. 

To access the reports click either the print button on the tool bar  or select the 'Print' sub-menu on
the 'File' menu. The 'Open Report' dialog will then be shown allowing the user to select which report to
generate.

The user can then select a report and click 'Open' to open, to cancel click 'Cancel'. Double clicking on a
report will open the report.

The following reports are included with the program:

Animal Identification Animal Status Heat Detection In Parlour Feed

Mastitis Medicines Milk Production Out of Parlour Feed
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When the user click's open, the report will be generated, please note reported with a large number of
search filters attached to them may take a long time to render. Below is shown the 'In Parlour Report';

The Report Preview dialog allows the user to preview a report before printing it out. The dialog has
some simple controls, as detailed below:

The button functions are detailed below;

• The Change Report button, this button allows the user to change which report is being viewed.

• The Print button, this button opens the print dialog in order to print the report out.

• The Print Setup button, this button allows the user to change printer settings for the report.

• The Export button; This button allows the report to be exported as a CSV or Microsoft Excel file 
for editing in a spreadsheet like Microsoft Excel, or in another application.

• The Zoom In & Zoom Out buttons, these buttons allow the user to zoom into and zoom out
from the report.
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The ATL Cowculator 2010 Report Designer, as show below, allows the user to design their own reports
to include different columns and animals depending on the report configuration.

The main menu tool bar at the top of the dialog allows the user to add, remove and edit columns and
search filters attached to the report. The tool bar buttons are described below;

• The Open Report button;  Opens a saved report, or allows the user to create a new report.

• The Save Report button;  Saves the current report.

• The Add Column button;  This button Adds a column to the report.

• The Add Search Filter button;  This button Adds a search filter to the report.

• The Delete Column / Filter button;  The button will delete the selected column, or filter.

94



                  Innovation In and Out of Parlour ATL Cowculator 2010 - User Guide

Further to the buttons outlined on the previous page. The designer has the ability  to re-order the

columns and search filters using the move group of buttons;   The first moves an
item to the top of the list, the last to the bottom, the centre two move the item up or down respectively.

The Report name box allows the user to name the report. The box will default to 'No Name' when a new

report is created; .

To Add a column to a report click the  button, this will show the Add Data Source dialog; as shown
below;

The dialog allows the user to add a column, then set its width, and any colour information. Clicking 'Add
Column' will add the new column to the report and allow the user to add another column. Clicking
'Close' will return to the report designer. 

When the Add Search Filter button;  is clicked, the Apply Filter dialog is shown;

The dialog will allow the addition of filters to the report so only specific cows will be listed, for example
animals with yields above 10 litres.
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The Apply Filter dialog also allows the user to mark animals rather than just include them, clicking the

 button next to the Options label will show the advanced options for the filter;

The Advanced Options enable the creation of filters which add animals to the current filter ('Merge') and
also highlight the rows with user defined colours.
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27 MicroMarque3s Tools
ATL Cowculator 2010 includes a tool to aid in editing the settings on a MicroMarque3s control. The tool
is accessible through the Tools menu.

The ATL MicroMarque3s Settings editor is shown above, it allows the user to download, save, load and
upload settings from and to the ATL MicroMarque3s parlour control.

Double clicking on an editable subroutine will allow the user to edit the value. The changes can then be
uploaded back to the control. It is important to note, that editing settings with this tool should be done
when the system is not in use, as the control will become unresponsive during the communications.
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28 MicroMarque4 Tools
ATL Cowculator 2010 includes tools to aid in linking animals used in conjunction with the ATL Micro
Marque 4 Drafting Gate System. These include;

• Drafting Gate Tag Linker: This tool is used to link unlinked tags which are read by the drafting
gate system.

• Drafting Gate Watcher: This tool is used to watch all tag codes being read by the Drafting Gate
system.

The Drafting Gate Tag Linker, as shown below, allows the user to wait for unlinked animals in the herd,
then link them as they walk through the drafting gate system.

Here it is shown waiting for a tag to be read by the system. When a tag code is received, it will be
displayed, the dialog will then wait for the user to enter an animal number. Any tags read whilst the user
is entering a tag number will be remembered and displayed consecutively. 
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Below, the drafting gate tag linker tool is waiting for a user to enter a valid animal number.

The  user  can  enter  an  animal  number  and  click  link.  The  animal  will  then  be updated  or  created
depending on whether it exists or not in the herd. If the user wishes to ignore the tag they can click
'Skip' and the tag will be ignored.

Please Note that  when running in  stand alone mode,  the tag codes are only  linked  locally  in ATL
Cowculator and will need to be sent to the ATL Micro Marque 4 before they will be functional, this can
be accomplished by sending to ATL Micro Marque 4.
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The Drafting Gate Watcher is a tool used to view all tags passing through the drafting gate system. It
will wait for a tag read, then display the tag code. If the tag is linked to a animal it will also display the
animal's number.

Above shows a linked animal's tag code and number; below an unlinked tag is displayed;
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The Manual Drafting Control allows the user to control the drafting gate manually, so that it will ignore
all tag codes from ear tags. The dialog is shown below;

Here the user has the choice of making all animals go one of five ways or to return control to normal
drafting. Clicking any of the buttons will send the changes to the ATL Micro Marque 4 with immediate
effect.
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This page is left blank for any notes you wish to make
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